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Course map

Model & Uncertainty

Specify inputs, randomness, and mechanisms

Simulation
Generate synthetic outcomes and assess performance

Decide / Optimize

Search for better configurations under uncertainty
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Course map

Lecture sequence

1.

© O N O A WD

Introduction to simulation

Drawing from distributions

The Poisson process

Discrete events simulation

Statistical analysis and bootstrapping
Variance reduction

Markov chain Monte Carlo methods
Introduction to optimization (heuristics)

Multi-objective optimization

3/63



Course map

What you will be able to do
» Build a simulator and generate reliable outputs (not just one run).
» Quantify uncertainty (confidence intervals, bootstrap) and reduce variance.
» Use Monte Carlo and MCMC to sample complex distributions.

» Optimize decisions using simulation outputs (single- and multi-objective).
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Outline

Motivation
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Engineering systems

Definition (Wikipedia)
Combination of components that work in
synergy to collectively perform a useful function.

T

Properties

» Complex
Large

>

» Designed
» Configurable
>

Interactions with external world
Source: Wikipedia
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Engineering systems

Objectives
» Design
» Maintain
» Operate

Time horizon
» Long-term
» Medium-term
» Short-term

Source: Swiss Learning Exchange
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Engineering systems

Mathematical and digital twins

» Modeling
» Simulation
» Optimization

Source: Konica Minolta
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Engineering systems

Modeling Simulation Optimization
Roles Represent Predict Improve
How? Capture causal Capture the Investigate
effects propagation of better configu-
uncertainty rations
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Outline

Modeling
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Modeling

System
A system can be represented as follows:

z=h(x,y,u;0)

Control — u ‘ External input — y

Complex system — state x

Y
Indicators — z
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Modeling

z=h(x,y,u;0)

Example

A car:
> x captures the state of the system (e.g. speed, position of other vehicles)
» y captures external influences (e.g. wind)

» u captures possible human controls on the system (e.g.
acceleration/deceleration)

> z represents indicators of performance (e.g. oil consumption).
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Modeling

Decompose the complexity

» The model h is usually decomposed to reflect the interactions of the
subsystems
» For example,

» a car-following model captures the target speed of the driver,
» an engine model derives the actual consumption as a function of the
acceleration.
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Modeling

I knew it ! Chicker’
Causal effects A comes firgt |
» Very important to identify the r
causal effects
» Failure to do so may generate
wrong conclusions

Forecasting

Assumption: causal effects are stable
over time and configurations of the
system.
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Data can be misleading
Chocolate Consumption, Cognitive Function, and Nobel Laureates

Nobel Laureates per 10 Million Population
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Inference

Data collection
On an existing system, collect N observations of x,, y,, un, z,, n=1,..., N.

Goodness of fit
For a given value of 0, “distance” d,(0) between
» the predicted value h(x,, y,, u,;0), and

» the observed value z,.

Inference
Find © that minimizes the total distance:

N

0= argming Z d,(0).

n=1
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Outline

Simulation
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Simulation

Simulation is more than simply applying the model.

z=h(x,y,u; @)

Control — u ‘ External input — y

Complex system — state x

Y

Indicators — z




Simulation

Z=h(X,Y,U.0) +e,

N a

Control — u External input — y

Ex N

Complex system — state x

Y
Indicators — z |« &7
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Simulation

Propagation of uncertainty

Z=nhX,Y, U0 +e,

» Given the distribution of X, Y, U and ¢,
» what is the distribution of Z7?
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Why is it difficult?

Arithmetic of random variables
» Let X and Y be two random variables (assume independent for now)

» Define a new random variable
Z=X+Y
» What is the probability distribution of Z7

Analytical solution
The probability density function of Z is given by a convolution:

fz(z) = JOO fx(x) fy(z — x) dx

—00
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Independence is convenient, dependence is common

In practice, variables are rarely independent
» Correlated inputs: demand, weather, incidents, prices.
» Common shocks: one event affects many components simultaneously.

» Time dependence: queues, inventories, fatigue, learning.

Takeaway

» Convolutions become harder; analytical results become rarer.

» Simulation remains straightforward: sample the joint distribution and
propagate it through h.
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Why propagate uncertainty?

Key difficulty

» Convolution integrals quickly become intricate.

Closed-form expressions are rare.

>
» The situation worsens for nonlinear functions or many variables.
» Independence is convenient, but dependence is common.

>

Convolutions become harder; analytical results become rarer.
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Example: sum of two uniform random variables

Assumptions
X~U(0,1), Y~U(01), Z=X+Y

Result (after convolution)
The density of Z is triangular:

0, z <0,

z, 0<z«1,
fz(z) =

2—z, 1<z<?2,

0, z> 2.
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Simulation: propagate uncertainty numerically

Core idea
» Generate numerical values that follow the distribution of interest
» Apply standard arithmetic to these values

» Let empirical distributions replace analytical formulas

Draws from a random variable
» Let X have pdf fx
» A draw from X is a numerical value generated according to fx
» Consider independent draws Xi, ..., Xg
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Simulation: propagate uncertainty numerically

Key convergence property (Law of Large Numbers)

Assume Xi, ..., Xg are i.i.d. draws from fx. For any interval [a, b],

R b

1 Z as.

E I{X, < [a, b]} m J &(X) dX.
i=1 a

Preview
Later, MCMC generates dependent draws; convergence still holds under

additional conditions.
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[llustration: simulation replaces convolution

Procedure
» Draw Xi, ..., Xr ~U(0,1)
» Draw Yi,..., Yr ~U(0,1)
» Compute
Z =X +Y,, r=1,...,R

» Analyze the empirical distribution of Z,
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[llustration: simulation

replaces convolution

Histogram of X - U(0,1)

00 02 04 o6 08 1o

Histogsam of ¥ ~1(0,1)

00 02 04 06 08 10

v
Histogram of Z =X+ Y.

- Siated 7
— True density
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[llustration: simulation replaces convolution

Key message

» No integrals, no convolutions
» Only draws and simple arithmetic
» The distribution of Z emerges automatically
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Simulation

Z=h(X,Y,U.0) +e,

N a

Control — u External input — y

Ex N

Complex system — state x

Y
Indicators — z |« &7
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Simulation

Sampling
» Draw realizations of X, Y, U, ¢,
» Call them x", y", u", €

» For each r, compute OROE8Md
OIEEICIED

2 =h(x",y  u"0)+ €

» z" are draws from the random variable Z
Analysis
» Generate many draws from Z.

» Analyze their empirical distribution.
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Importance of number of draws
Theory vs. practice

» Theory: true distribution of Z when r — co.
» Practice: finite number R of draws.

» If R is too small, simulator output is just noise.

Analogy with real world

» Nature also generates instances of a complex random variable.

» Experiments must be repeated in order to reach conclusions.

Example: policy analysis
» The real impact of a policy is difficult to analyze.

» Incomplete results consistent with expectations may lead to erroneous

conclusions.
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Two sources of variability

Two different questions

» Qutput uncertainty (system variability): how variable is Z itself?

> Monte Carlo error (estimation noise): how accurate is Zx as an
estimate of E[Z]?

Key distinction
» Even if Z is highly variable, Zz can be estimated accurately with large R.
» Even if Z is not very variable, Zg can look noisy when R is small.

Typical relationship (i.i.d. runs)

= Z
Var(Zg) = Vai?( ) = Monte Carlo error decreases as 1/v/R.
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Example: enhancing road safety

Traffic accidents in Switzerland
» The Swiss Federal Roads Office has proposed new safety measures.

» The initiative aims to identify accident-prone locations and significantly
lower speed limits in those areas.

» The TCS has organized a referendum opposing these measures, arguing that
they are not sufficiently effective in improving safety and significantly hinder
mobility.

» You have been tasked with evaluating the actual effectiveness of these safety
measures.
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Example: enhancing road safety

Methodology: simulation

» Simulate the number of accidents before and after the implementation of
the safety measures.

» Based on existing literature, the number of accidents in Switzerland can be
modeled using a uniform distribution ranging from 0 to 12.
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Current situation: simulated number of accidents
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|dentification of dangerous spots
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Implementation of the measures
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After implementation: simulated number of accidents
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Analysis

PROOE

Data
» Before: 12 + 11 + 11 = 34 accidents
> After: 9 + 2 + 6 = 17 accidents
» 50% reduction.

Conclusion

As expected, safety measures reduce the number
of accidents.
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Example: enhancing road safety
Major flaws

» Causal effects are not accounted for in the model.
» The simulation was performed using only a single run.
» Not all locations were re-simulated.

» Confidence in the conclusions is strengthened by their alignment with
expectations.

What should have been done
» Run multiple simulations to estimate accident occurrences more robustly.

» The expected average number of accidents should be around 6 at all
locations, regardless of the speed limit.

» A formal statistical test would likely fail to reject the null hypothesis,
suggesting that the speed limit has no measurable effect in the simulation.
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Outline

Data analysis
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Simulation

Derivation of indicators from the distribution
» Mean
» Variance
» Modes
» Quantiles
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Statistics

© MAZIL ANDEZSON W ANDEZTSONS, COM

Indicators
» Mean: E[Z] ~ Zr = %ZL z"
» Sample variance:
Var(Z) = s} = 75 SR (2 —ZR)?
» Modes: based on the histogram
» Quantiles: sort and select

"Numbers don't lie. That's where we come in.”

Important: there is more than the mean
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The mean

The
State of
the drunk
at his AVERAGE
postion is

ALIVE

But the AVERAGE State
of the drunk is

DEAD

[Savage et al., 2012]
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The mean

The flaw of averages

[Savage et al., 2012]

E[Z] = E[A(X, Y, U;8) + €] # h(E[X], E[Y], E[U]; 8) + Ele.]

.. except if his linear.
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There is more than the mean

Example

» Intersection with capacity 2000 veh /hour
» Traffic light: 30 sec green / 30 sec red

» Constant arrival rate: 2000 veh/hour during 30
minutes

» With 30% probability, capacity at 80%.

» Indicator: Average time spent by travelers
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There is more than the mean

400

Frequency

200

390 686 1100
Average travel time (sec)
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Pitfalls of simulation

Few number of runs
» Run time is prohibitive

» Tempting to generate partial results rather than no result

Focus solely on the mean

» The mean is useful, but not sufficient.
» For complex distributions, it may be misleading.

» Intuition from normal distribution (mode = mean, symmetry) do not hold in
general.

» Important to investigate the whole distribution.

» Simulation allows to do it easily.
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Challenges

» How to generate draws from Z7

» How to represent complex systems? (specification of h)
» How large R should be?

» How good is the approximation?
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Pseudo-random numbers
Definition
» Deterministic sequence of numbers

» which have the appearance of draws from a U(0, 1) distribution

Typical sequence

X, = ax,—1 modulo m

» This has a period of the order of m
» So, m should be a large prime number
» For instance: m=23—1land a=7°

» x,/m lies in the [0, 1[ interval
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Pseudo-random numbers

Modern practice

» We almost never implement RNGs ourselves.

» We use tested generators from standard libraries (period, equidistribution,
statistical quality).

» What matters in practice: seeds (reproducibility) and independent
replications.
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Pseudo-random numbers

Python/Numpy example (reproducibility)

import numpy as np

rngl = np.random.default_rng (2026)
x1 = rngl.uniform(0.0, 1.0, size=5)
print (x1)

rng2 = np.random.default_rng (2026)

x2 = rng2.uniform (0.0, 1.0, size=5)

print (x2)

[0.17893481 0.63991317 0.4672684 0.37050053 0.35491733]
[0.17893481 0.63991317 0.4672684 0.37050053 0.35491733]
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Pseudo-random numbers
Python/Numpy example (independent replications)

import numpy as np

master = np.random.default_rng(12345)
seeds = master.integers (0, 2%*x63 - 1, size=3)

for r, s in enumerate (seeds):
rng = np.random.default_rng(int(s))
x = rng.normal (size=1000)
print (f"Replication {r}: mean={x.mean():.3f}, std={x.std ()

Replication 0: mean=0.014, std=1.009
Replication 1: mean=-0.015, std=0.992
Replication 2: mean=-0.058, std=0.999
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Pseudo-random numbers

What this shows
» Different replications produce different realizations.
» Summary statistics fluctuate around their theoretical values.

» Re-running the script produces identical output (reproducibility).
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QOutline of the lectures on simulation
Drawing from distributions
Discrete event simulation

Variance reduction

>
>
» Data analysis
>
» Markov Chain Monte Carlo

Reference
[Ross, 2012]
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Outline

Optimization
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Optimization

Assumptions

» Control U is deterministic.
Z(u) =h(X,Y,u)+e¢,

» Various features of Z are considered: mean, variance, quantile, etc.

flu) =glzilv), ... zn(u))

» If not, it is called multi-objective optimization.
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General framework: the black box

A

Control — u External input — y

Complex system — state x
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Optimization problem

min £(u)

subject to
ueUCR”

» u: decision variables

» f(u): objective function
» u € U: constraints

» U: feasible set
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In this course. ..

» Classical optimization problems
» Heuristics

» Multi-objective optimization
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Summary
Modeling

» Decomposition of the complexity.
» Causal effects.

Simulation
» Propagation of uncertainty.
» Requires many draws.
» Analysis of the entire empirical distribution.

» There is more than the mean.

Optimization
» |dentify the control that improves a function of the indicators.

» Optional: multi-objective optimization.
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